
         Microsoft Access Glossary

32-bit
A 32-bit operating system allows Windows 95 to 
access computer data faster than 16-bit systems by 
taking it in larger pieces.

Action Queries
An action query not only finds designated records, but 
performs some sort of action on those records.

Add Line Mouse Pointer
The mouse pointer changes to an add line mouse 
pointer after you click the Line button.

Advanced Button
Use the Advanced button to further define the search 
for a file.

ALT
The [ALT] (or Alternate) key on the keyboard is used in
conjunction with other keys and mouse actions to 
perform various commands and functions.

Append Queries
An append query adds the records from one table to 
the records in another table.

ASCII
An ASCII file is a text file and may be either delimited 
or fixed width.

AutoCorrect
AutoCorrect is a feature that automatically corrects 
commonly misspelled words and allows the user to 
enter shorthand versions of frequently used words.

AutoForms
An AutoForm is a quick form that automatically 
includes every field from the table or query on which it 
is based.

AutoNumber The AutoNumber format automatically assigns a new 
number when a record is entered. This is a good 
format to use for primary keys, because it ensures that
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unique numbers will be assigned to each record.

AutoReports
An AutoReport is a quick report that automatically 
includes every field from the table or query on which it 
is based.

Axes
Axes are the lines that frame the bar chart area and 
provide a means for comparison. The Y axis is usually 
vertical and the X axis is usually horizontal.

Back Color Button
Use the Back Color button to change the background 
color of the selected control.

Back Style
The Back Style option allows you to determine 
whether the color of a control will be visible or 
transparent.

Bar Chart
A bar chart uses colored bars of various heights or 
lengths to represent each item.

Bitmap
A bitmap is a type of graphics file that is usually 
created in MS Paint.

Border Width Button
Use the Border Width button to change the border 
width of the selected control.

Bound Control
A bound control in a form or report is one that is used 
to show or edit information from a table or query, such 
as a text box.

Browsing
Browsing means looking through a computer system 
to locate files, folders, applications, or printers.

Button A button is an icon that represents a tool or command.

By Column Button Use the By Column button in Microsoft Graph to place 
data series in columns.



By Row Button
Use the By Row button in Microsoft Graph to place 
data series in rows.

Captions
Captions serve as column headers in tables or as 
labels in forms.

Click-and-drag

Click-and-drag refers to pressing and holding the left 
mouse button while moving the mouse. Click-and-drag
is often used to move selected items or to select 
several items at one time.

Column Command
Use the Column command on the Insert menu to 
insert a new column to the left of the current column in
Datasheet.

Column Headers
Column headers are the identifiers at the top of each 
column in a table. The names of the headers should 
correspond to the field names.

Columns
Columns are the vertical divisions of a table. Fields 
are represented in tables as columns. Each column in 
the table represents one field.

Context-sensitive
Context-sensitive refers to information or menus that 
are specific to the selected object.

Control

A control is any graphical object on a form or report 
that can be selected or manipulated. Controls include, 
but are not limited to, text boxes, labels, graphics, and 
lines.

Criteria Row

Use the Criteria row in the design grid to specify 
parameters that desired records must meet. For 
example, a criterion might tell the query to select all 
customer records having area code 407. A criterion is 
usually entered using an expression. 

Data Data is related information that is grouped and 
manipulated by an application. In Access, data is 
entered into the fields of a table.



Data Labels
Data labels provide additional information about the 
data in your chart.

Data Types
A field's data type specifies and limits what kind of 
data may be entered into that field.

Database

A database is a collection of records pertaining to a 
specific topic. Examples of databases include: 
customer lists, order records, telephone books, 
product listings, and Rolodex files.

Database Window

The Database window appears when you open a 
database. Depending on which option button you 
select, the Database window shows you a list of 
available tables, queries, forms, reports, macros, and 
modules. The Database window allows you to select 
whether you want to design, edit, view, or create 
specific objects.

Database Wizards

A Database Wizard creates a database for you, 
automatically setting up appropriate tables, forms, and
queries. Access provides more than 20 Database 
Wizards, each devoted to a specific use, such as 
household inventory, ledgers, or inventory control.

Databases Card
Use the Databases card in the New dialog box to 
select one of the Database Wizards.

Datasheet View
Use a table's Datasheet view to view, edit, or add 
data.@10

Datasheet View
A table's Datasheet view allows you to view, edit, or 
add data to the table.

Default
A default setting is the software manufacturer's preset 
option for a particular command or function. Default 
settings can be changed.

Delimited
In a delimited text file, characters such as commas or 
tabs separate the fields.



Description
Use the description column in the Table Design view 
to describe each field in the table.

Deselecting
Deselecting is removing the active mark or highlight 
from an object.

Design Button
The Design button allows you to open the selected 
object in Design view, where changes can be made to 
the structure of the object.

Design Grid

The design grid is a graphical tool that allows you to 
create a query by placing fields from the upper half of 
the Query window into the design grid in the lower half
of the window.

Design View
A table's Design view allows you to add fields or make
changes to the overall formatting and properties of a 
table.

Detail And Summary

Use the Detail And Summary option in the Show 
section of the Summary Options dialog box to create a
report that includes each record along with the 
summary calculations.

Detail Section
The detail section of a form contains one record. It 
should consist of any labels and fields that you want to
display on the form.

Drag-select
Click-and-hold the left mouse button and move the 
mouse to select text or items.

Drop-down List
A drop-down list is a list of choices that become 
available by clicking a text box or its adjacent down-
arrow.

Embedded Object
An embedded object is linked to the original data and 
is updated when the original data is updated or 
changed.

Embossed Text Embossed text is similar to shadowed text, though the 
effect is more of a highlight than a shadow. Embossed



text takes the same color as the background and 
appears slightly raised.

Expression An expression is used to specify criteria in a query. 

Field

A field is a category of information, such as a phone 
number, product name, or unit cost. If a table contains 
customer information, its fields might be first name, 
last name, address, city, state, zip code, and phone 
number.

Field List

The field list appears at the top of the Query design 
window when you have added a table to the query. It 
lists all of the fields in the table, and you can use it to 
add fields to the query design grid.

Field List Button
Use the Field List Button to open or close a list of 
fields available for use in a report or form.

Field Properties
A field's properties govern how its data is displayed or 
stored.

File Management
File management is the process of organizing objects 
contained on the hard disk into a formal structure of 
folders, subfolders, and files.

File Type
File type refers to the format the file was saved in and 
often refers to the application that created the file.

Files
A file is a collection of data referred to by a given 
name.

Filter By Form

A Filter By Form lets you designate the records you 
are seeking by opening a blank view of your datasheet
or form and letting you type in or select from a drop-
down list the data you are seeking.

Filter By Selection A Filter By Selection lets you designate the records 
you are seeking simply by clicking the value you are 
looking for within the form or datasheet. 



Filters

A filter is a feature that provides a quick way to select 
and view designated records. Filters may be applied 
from within tables, forms, or the datasheet of a query. 
They can also be run from within another filter. A filter 
cannot be based on multiple tables or be used to 
perform calculations.

Find Command
The Find command allows you to search the computer
for files and folders based on particular criteria.

Find Now Button
Use the Find Now button to initiate the search for a 
designated file.

Fixed Width
In a fixed width file, fields are arranged in columns 
with spaces in-between.

Flipping
Flipping is the action of rotating or flipping an object 
either horizontally, vertically, left, or right.

Folders
Part of the organizational system of the computer disk,
folders can contain files or other folders.

Font
A font is a style and size of type, such as Times New 
Roman, 12 point, bold.

Fonts Folder
The Fonts folder is an area on the system used for 
controlling and managing type styles.

Fore Color Button
Use the Fore Color button to change the color of 
selected text.

Form

A form is a feature that shows only the information you
want to see, in the order you want to see it. A form is 
used to view data in a database, enter new data into 
the database, or edit data.

Form View Button Use the Form View button to switch between the 
Design, Form, and Database views of your form.



Form Wizard
Form Wizard provides step-by-step help in creating a 
form.

Formatting
Formatting is the way entries in a field are displayed or
printed. For example, if 5.49 is entered into a field 
formatted as currency, it will display as $5.49.

Frame
A frame is a placeholder that may be inserted for a 
graphic.

Gridlines

Gridlines in a report are non-printing lines that help 
you to line up or position controls. They can be turned 
off or on from the View menu. Gridlines in a form are 
non-printing lines that help you to line up or position 
controls.

Group

When you group data in a report, you tell Access that 
you want certain data arranged together. For example,
you might want to group order records by item 
number, with all the orders for a particular item 
number listed together.

Grouping Objects
Grouping objects combines multiple objects into a 
single object with its own selection handles.

Groups/Totals Report

A Groups/Totals report, which can be created using 
Report Wizard, organizes data in a row-and-column 
format, grouping records based on specified fields. 
Totals and grand totals may then be calculated for 
each grouping.

Heading Section

The heading section of a form appears at the top of 
the form and usually consists of the title of the form. 
Other data that you may want in a heading section 
might be the date or the company name.

Hot Spot A hot spot is a green word or phrase that can be used 
to open help about that particular word or phrase. 
Click a hot spot with a solid underline to open a help 
document about the phrase. Click a hot spot with a 
dotted underline to open a pop-up window about the 
phrase.



Image Button
Use the Image button to create a frame for a graphic 
that cannot be edited from within Access.

Image Mouse Pointer
The mouse pointer changes to an Image mouse 
pointer when you can draw a frame for a graphic.

Import
Importing is the process of bringing in the data from 
another database (including non-Access databases).

Index
Access uses indexes to help locate or sort records 
more quickly.

Input Mask

An input mask helps to control the values that are 
entered into a field and might include dashes, spaces, 
or parentheses. You then fill in the blanks. When you 
use Table Wizard, input masks may be automatically 
applied to certain fields, such as phone numbers or zip
codes.

Insertion Point
The insertion point is the vertical, flashing bar that 
shows you your current position on screen. Whatever 
you type will be entered at this point.

Insertion Point
An insertion point is the place where text or graphics 
will appear in the document.

Join Lines
A join line is drawn between two fields in different 
tables to indicate that the two tables are linked or 
joined by the data in those two fields.

Label

A label is any area on a form or report where titles or 
descriptions are shown. The label can stand alone or 
be attached to a control. If a label is attached to a 
control, it often contains the name of the field 
represented by the control.

Label Button Use the Label button to create a label.

Label Mouse Pointer The mouse pointer changes to a capital A with a plus 
sign once you have clicked the Label button and are 



ready to insert a label.

Label Wizard

Label Wizard is one of the report wizards that runs you
through a series of step-by-step dialog boxes that 
allow you to select the size of labels you wish to 
create.

Labels
A label is any area on a form or report where titles or 
descriptions are shown. A label can stand alone or be 
attached to a control.

Landscape
Landscape refers to the orientation of the paper. In 
Landscape mode, the report is formatted to fit 11" x 8" 
paper.

Last Record Button
Use the Last Record button to take you to the last 
record in the table or form.

Layout

The layout of the report is how the data is placed on 
the page, including how it is aligned and whether it is 
in a single column or multiple columns. Access 
provides several preformatted layout options from 
which to choose.

Legends
A legend provides a key to the data illustrated in a 
chart.

Line Button Use the Line Button to draw a line.

Linking Tables
When an Access table is linked from another 
database, you have access to all of the records in the 
linked table.

Links
Links tell Access how the tables are related to each 
other by indicating which fields they have in common.

Lookup Field
A Lookup field points to another table and lets you 
select data from that table by using a drop-down list.



Macro

A macro is an advanced option used to automate a 
series of tasks. You might want to write a macro to run
functions that you perform on a regular basis, such as 
printing particular reports whenever you open a 
database.

Mailing Labels
Mailing Labels are address labels that are affixed to 
sales flyers, catalogs, or letters.

Main Form
A main form is the primary form and may contain one 
or more subforms.

Make-table Queries
A make-table query takes the selected records and 
creates a new table with them.

Margins
Margins are the areas that border the printed portion 
of the page along the top, sides, and bottom.

Marquee-select
Marquee-selecting is the process of clicking-and-
dragging the mouse pointer over a group of objects 
until a dotted line forms a box around it.

Match
The Match criterion in the Find in field dialog box lets 
you specify what part of the field needs to match the 
text you type in the Find What box.

MB
MB (or megabyte) is a data measurement. One 
megabyte is equal to 1,000 kilobytes of data.

Menu Bar
A menu bar is a list of commands across the top of the
screen that may be opened to reveal additional 
commands.

Microsoft Graph
Microsoft Graph is an application used within Microsoft
software, such as Access, Word, and PowerPoint, to 
create graphic representations, or charts, of your data.

Module A module is a unit of Visual Basic For Applications 
programming code and is much more complex than a 
macro. Modules allow you to create very 
sophisticated, customized databases; however, they 



require the ability to program in the Visual Basic For 
Applications language.

More Files
Use the More Files option to see other databases that 
you have worked with if the database you want is not 
in the original list.

Multiple Table Queries
Multiple table queries are queries that use more than 
one table.

Multitasking
Multitasking is the process of running more than one 
application or activity at a time.

Name Property
The Name Property on the property sheet is used to 
rename a page on a tab control.

Navigation Buttons
The navigation buttons are a group of five buttons 
located at the bottom of a table or form. They move 
you to various records within the table or form.

Navigation Keys
Navigation keys are keyboard keys that allow you to 
move around within a document, such as [PAGE UP], 
[HOME], and the arrow keys.

New Button
Click the New button to create a new object, 
depending on which object tab is selected.

Next Record Button
Use the Next Record button to take you to the next 
record in the table or form.

Normalization
Normalization is the process of splitting a table into 
related tables, in order to eliminate wasted space, 
redundancy, and keying errors.

Number Across
Number across refers to the number of labels that may
be printed in a single row across the page or sheet.

Object Tabs The object tabs, which are located along the top of the
Database window, allow you to switch between the 
available types of objects: tables, queries, forms, 



reports, macros, and modules.

Objects
Objects are any data that can be used in an 
application or shared with other applications.

Office Assistant
The Office Assistant is a feature that provides help 
and tips as you work in Access.

OLE
Object Linking and Embedding (OLE) are processes 
that permit the sharing of files and objects between 
applications.

Open Database Button
Use the Open Database button to access an existing 
database so that you can open it.

Open Hand Mouse Pointer
The Open Hand mouse pointer indicates that the 
pointer is in the correct position to move a text box 
and its attached label.

Option Button
An option button in a dialog box is a round button that 
is used to select one of several mutually exclusive 
commands.

Page Each tab on a tab control is called a page.

Page Footer Section
Any controls in the Page Footer section in the report 
design window will appear at the bottom of every page
of the report.

Plot Area
The plot area is the chart. It includes the axes, the 
data labels, the grid, and the bars, lines, or wedges 
that make up the chart.

Point
Pointing is the action of placing the mouse pointer 
over the desired object or text.

Portrait
Portrait refers to the orientation of the paper. In 
Portrait mode, the report is formatted to fit 8" x 11" 
paper.



Primary Key

The primary key is the unique identifier for each 
record, such as an employee number, a product 
number, or a customer number. Access will not allow 
duplicate entries in a field that is set up as a primary 
key.

Primary Key Fields
The primary key is the unique identifier for each 
record, such as an employee number, a product 
number, or a customer number.

Print Area

Within a report, the print area is the area that will be 
printed, even though it may contain blank areas. In 
Report Design view, this is shown by default as a 
white background.

Print Preview
Print Preview is one of the report views. It allows you 
to see how the document will look when it is printed.

Properties Button
Use the Properties button to open the property sheet 
for the selected control.

Property Sheet
The property sheet contains settings that control the 
characteristics or appearance of the selected control.

Query

A query is a question that you ask about the data in 
your table(s). For example, you may want to know 
which of your customers bought pinto beans in March. 
Access searches designated tables or queries and 
provides you with an answer.

Query Design View
Query Design view lets you build or edit a query using 
the design grid.

Query Type Button
Use the Query Type button to begin creating a specific
type of query.

Query View Button
Use the Query View button to switch between the 
Design, SQL, and Datasheet views of your query.

Raised Special Effect The Raised special effect makes the selected control 



appear slightly elevated from the background.

Record

A record is all of the information collected about a 
specific event, thing, product, or person, such as a 
customer record. A record can consist of many fields. 
For instance, a customer record could consist of the 
customer's first name, last name, address, city, state, 
zip code, and phone number.

Record Indicator
The record indicator is a small box that appears on the
scroll box when the scroll box is clicked or moved. It 
displays which record number you are at in the table.

Record Selector
A record selector is the small box to the left of a record
or row in a table. Click a record selector to select the 
adjacent record.

Recordset

A Recordset is the result of a query. While the 
Recordset may look like a table or Datasheet, it exists 
only in the computer's memory. Once you close it, it no
longer exists unless you save it.

Referential Integrity

Referential integrity is a system of rules that Access 
uses to make sure that relationships between records 
in related tables are valid, and that you don't 
accidentally delete or change related data.

Relational Database

A relational database management system is an 
application that allows you to organize, manipulate, 
query, and view your data, while building links 
between related topics. Access is a relational 
database management system.

Relationships

Relationships are ties that are created between tables 
in the database so that Access can combine data from
more than one table to create reports. It is how tables 
determine how they correspond to each other.

Relationships Button
Use the Relationships button to open the 
Relationships window so that you can view, edit, or 
define relationships between tables and queries.

Replace Text Box Use the Replace text box in the AutoCorrect dialog 



box to enter the text you want to replace.

Report

A report is used to show and print selected information
from a table in a customized manner. A report differs 
from a form because it does not allow you to make 
any modifications or edits to the actual records within 
the table(s).

Report Design View

Report Design view lets you create a report from 
scratch or modify the way a report appears. Fields, 
lines, labels, color, and graphics can be added to a 
report in Design view.

Report Sections

In Design view, a report is divided into different 
sections, which vary depending on the individual 
report. Some common sections include the Report 
Header, Detail, and Page Footer sections. When 
printed, some sections, such as Report Header, 
appear only once on the report. Other sections, such 
as the Detail section, are repeated over and over until 
all the records are shown. 

Report Wizard
Report Wizard helps you create a report by giving you 
a variety of choices in a series of dialog boxes.

Right-click Menu
A right-click menu is a context-sensitive menu for an 
object.

Right-drag
Right-dragging is the process of pressing and holding 
the right mouse button while moving the mouse.

Row Selector
The row selector is the small box to the left of each 
field name in the upper half of the Table Design view 
window.

Rows
Rows are the horizontal divisions of a table. Each row 
contains a separate record.

Rulers In Form or Report Design View, horizontal and vertical
rulers located along the top and left side of the screen 
indicate your current position within the document. 
They can assist you in determining the size of a 
control or a section. They can be turned off or on from 



the View menu.

Run
When you run a query, you tell it to find and list the 
designated records.

Sample Tables

The Table Wizard provides numerous sample tables-
both business-related and personal-from which to 
choose. Select the type of table that most closely fits 
your application. Your selection of sample fields will be
based on the sample table you select.

Save As/Export Option
The Save As/Export option located on the File menu 
lets you save the selected object under a different 
name.

Screen Element
A screen element is an object on the screen, such as 
a button or a ruler.

Search Subfolders
Use the Search Subfolders option in the Advanced 
Find dialog box to extend your search through the 
current folder and all of its subfolders.@49

Section

A section is a portion of a form. A form contains at 
least one section, but can contain others. The most 
common sections used on forms are the heading and 
detail sections.

Select
You select, or highlight, an object by clicking it with the
mouse. In order to work with an object, you must first 
select it.

Select Query
A select query retrieves a set of records based on the 
fields and criteria designated in the design grid.@61

Selecting
Selecting is highlighting an object or data in order to 
perform a command or operation.

Selection Bar
The selection bar is an unmarked area in the left 
margin of a document that allows for easy data 
selection.



Selection Query
A selection query searches for and creates a 
Recordset of all records that meet designated criteria.

Shadowed Button
Use the Shadowed Button to apply a border around 
the control and a shadow box behind it.

Shadowing Text
When you shadow text, you add a drop-shadow 
behind it. You can use shadowing for emphasis.

SHIFT

The [SHIFT] key on the keyboard is used in 
conjunction with other keys and mouse actions to 
capitalize letters and perform various commands and 
functions.

SHIFT+Click
[SHIFT+Click] is the process of holding down the 
[SHIFT] key while pressing the left mouse button.

SHIFT+TAB Use [SHIFT+TAB] to move one column to the left.

Shortcut
A shortcut points to an application or document in 
another location and is represented by an icon with an
arrow at the bottom.

Shortcut Menu
A shortcut menu shows a list of context-sensitive 
options. (See Right-click Menu.)

Show Table Button
Use the Show Table button to open a dialog box that 
lets you add a table to the query or the Relationships 
window

Show Table Dialog Box
The Show Table dialog box lets you add tables to your
query.

Single-column Report

A single-column report prints all the data in one 
column. The quickest way to produce one that allows 
you to choose your fields is to use Report Wizard, 
then select Vertical under layout options.

Size Mode Size Mode specifies how a graphic will be sized.



Sizing Handles

Sizing handles are the small black boxes on the 
corners, sides, tops, and bottoms of selected text 
boxes or controls. You can resize the selected object 
by clicking-and-dragging one of these handles.

Sort

When you sort data in a report, you tell Access that 
you want the data arranged in a certain order. For 
example, you might want to sort order records by date 
ordered. You also can sort items within a group.

Sort Row

Use the Sort row to designate how the records will be 
sorted. The sort options available are ascending, 
descending, or not sorted. If you wish to sort records 
by the Cost field, then you would designate this in the 
Sort cell of the Cost column.

Special Effects
Access lets you change the appearence of a selected 
control by applying one of the following special effects:
Flat, Raised, Sunken, Etched, Shadowed, Chisled.

Specific Record Box
The Specific Record box tells you the number of the 
current record.

Status Bar

The status bar is a horizontal line of information 
located at the bottom of the Access window. It may 
provide instructions or descriptions as you work in 
Access.

Status Box
The status box is an informational panel on one end of
the Taskbar that provides information about the 
system.

Style
The style is the appearance of the report, including 
font styles, borders, and colors. Access has a number 
of preformatted styles from which to choose.

Subfolders Subfolders are folders within folders.

Subform
A subform is a form within a main form and can be 
displayed as a datasheet or as a single or continuous 
form.



Summary Report
A summary report takes all of the records in a table or 
query and, instead of listing each record separately, it 
summarizes or condenses them.

Switchboard

A switchboard is a form that allows you to open other 
reports or forms or to perform other actions. It is 
particularly useful when creating a database that will 
be used by those who are not proficient in Access.

Tabbed Form
A tabbed form contains more than one page for each 
record.

Table

A table is a feature, comprised of parallel columns and
rows, which is used to store, organize, and view data 
on a particular topic. A single database may contain 
numerous tables containing information about related 
topics, such as customer addresses, product prices, 
and order information.

Table Design View Window

The Table Design view window is divided into two 
halves. The top half allows you to select or add fields, 
while the bottom half shows the properties of the 
selected field.

Table View Button
Use the Table View button to switch between the 
Design and Datasheet views of your table.

Table Views
There are two places to work with tables in Access: 
Design view and Datasheet view.

Table Wizard
The Table Wizard provides step-by-step help in 
creating a table, selecting the fields, designating a 
primary key, and naming the table.

Tabs
Tabs are the titles of the cards found in some dialog 
boxes. Clicking one brings that card to the front.

Text Box Button Use the Text Box button to create a text box.@75

Text Box Mouse Pointer The mouse pointer changes to a text box pointer when



you can insert a text box in a form or report.

Text Boxes
A text box is an area on a form or report where data 
fields can be shown or changed.

Tick Mark Labels
Tick mark labels are the names that are applied to 
each section designated by tick marks.

Tick Marks
Tick marks are small marks that divide the sections of 
data along the axes of a bar chart.

Title Bar
The title bar is the area at the top of a window that 
contains the name of the application or open file.

Tool
A tool is a shortcut button, usually shown on a bar 
near the top of a window, that provides quick access 
to a commonly used command.

Toolbar
A toolbar is a group of tools of usually related 
functions.

Toolbox Button
Use the Toolbox button to toggle between opening and
closing the toolbox.

ToolTip
A ToolTip is a descriptive label that appears when the 
mouse pointer is held over a tool.

Truncated
Truncated text is the shortening or abbreviation of text 
due to limited display space.

Unbound Control
An unbound control in a form or report is not linked to 
a table or query and is usually a label, line, or graphic.

Ungrouping Objects
Ungrouping objects allows you to work with each part 
of a grouped object individually.

Unit Of Measure The Unit of Measure options for labels are as follows: 
English, which lists the available label sizes in inches. 
Metric, which lists the available label sizes in 



millimeters.

Up One Level Button
Use the Up One Level button to access the next 
higher-level folder on the computer.

Update Queries
An update query makes a change to designated 
records.

Wizards
Wizards guide you through difficult tasks using step-
by-step dialog boxes.

WYSIWYG
WYSIWYG is an acronym for What You See Is What 
You Get, meaning that what you see on the screen 
should be what prints on the page.

 


